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Fill in the blanks

1) Internet ~ 2) Network protocol ~ 3) Wired  4) Malicious software

5) LAN 6) Wannacry

True or False

1) False 2) True 3) True 4) True 5) False

Match the following

1) US Defense 2) Antivirus  3) CAN 4) FTP 5) Malware
Expand the following

1) Hyper Text Markup Language 2) Hyper Text Transfer Protocol

3) File Transfer Protocol 4) Wide Area Network 5) Local Area Network
Fill the Pyramid

1) Intranet 2) ARPANET 3) Norton 4) Virus 5) Worm 6) LAN

Identify the following networks

1) Personal Area Network 2) Local Area Network 3) Wide Area Network

4) Metropolitan Area Network 5) Campus Area Network

Who am I?

1. Intranet 2) Extranet 3) Internet  4) WannaCry

Answer the following

1) A computer network is a group of interconnected computers through cables,

telephone lines, radio waves, satellites or infrared light beams.

2) File Transfer Protocol is used to transfer a file from one system to another, under the

command of FTP user.

3) Local Area Network (LAN) is a computer network covering a small physical area
such as home, office, school, airport, hospital etc.

Wide Area Network (WAN) spans a wide geographical area such as cities, countries,
continents or even the whole of the world. WANs may transmit data over high-speed
phone lines or wireless links such as satellites to cover long distance. The word’s most

popular WAN is the Internet.



4) Internet is a global communication accessed through the web.

Intranet is the shared content accessed by members within a single organization.

5) Malware is the short form of malicious software. It is a type of destructive software
program that can reproduce itself and spread from one computer to another. It becomes
installed on a computer without the knowledge of the person using the computer.
Malware includes computer viruses, worms, Trojan horses, Spyware, Adware and any
other malicious software.

6) Network protocol is a set of rules which is used by computers to communicate with
each other across a network. Some protocols used in networks are: TCP/IP, HTTP, FTP
7) One of the largest cyberattacks ever is currently eating the web, hitting PCs in
countries and businesses around the world. It was attacked certain systems on May 2017

worldwide cyberattack by the WannaCray ransomware cryptoworm.

(™ | 2 MORE ON HTML )
I Fill in the blanks
1) Web 2) Embed or Video  3) Nested list  4) <TH>  5) Bordercolor list
6) Rowspan 7) Table 8) Colspan 9) Hyperlink 10) Forms

11 Match the following
1) <LI> 2) <OL> 3) <DL> 4) <TD> 5) <TR> 6) <A>
7) Email linking
I Write the Syntax of the following tags
1) Form tag: <form> ....... </form>
2) Hyperlink : <a>........... </a>
3) video or embed tag : <embed src="file.....”width="500" height="400">
4) Anchor tag : <a href="url” text> </a>
5) colspan : <td colspan = “number”>
6) Frame tag : <frame src = “html”>
v True or False
1) False 2)True 3)False 4)False 5)False 6)False 7)True 8)True
\% Tick the correct option
1) Bordercolor 2) <OL> 3) Hyperlinks 4) <BR> 5) Cellspacing
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Vil

Write the HTML commands for the following
1) <TABLE BORDER=BGCOLOR=BLUE CELLPADDING = 4>
2) <UL TYPE=“SQUARE">
3) <TH ALIGN = “center’> month </th>
4) <a href="Picture.gif”> garden.html</a>
5) <a href = “https://accounts.google.com” </a>
6) <input type = “checkbox” name = “toon” value = “Bug”> Bug
<input type = “radio” name = “shade” value = “Dark”> Dark
Answer the following
1) List are used to group related pieces of information together. There are three different
types of list, they are
* <UL> - Unordered list: An unordered list is used when the items are to be displayed
in any particular sequence.
* <OL> - Ordered list: Ordered list specifies items in sequential, numerical order.

* <DL> - Definition list: A definition list is a list of items, with a description of each item.

2) <TH> The <TH> tag defines a header cell in an HTML table.
<TD> The <TD> tag stands for table cell. It defines a standard cell in a HTML table

3) COLSPAN: Table cells can span across more than one column or row. The attribute
COLSPAN specifies width of the cell in terms of number of columns used when a cell
occupies more than one column.

ROWSPAN: ROWSPAN sets how many rows a cell spans. The ROWSPAN attribute
specifies the number of rows a cell should span. It decides the height of the cell in terms

of number of rows used when a cell occupies more than one row.
4) Forms are used to accept input from a user. A form includes checkboxes, radio
buttons, lists etc.

5) Frames allow you to have multiple sections of the browser window, called Frames.

6) External linking, Internal linking, Email linking
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Multiple choice question

1) Row 2) Draw 3) Cell Alignment  4) ALT+Home

True or False

1) False 2) False 3) True 4) False 5) True

Match the following

1) Merge Group 2) Draw group 3) Data group 4) Borders
Fill in the blanks

1) Merge cell 2) Table 3) Cell 4)Split 5) Alphabetical or Numerical

Werite the steps of followings

To Insert a Row:- Click on the cell -Click on insert option of the rows and columns
option.

To convert Text to Cell:- Select the text - Click on convert text to table option table-
insert tab- select tabs- separate text- convert text to table Enter ‘number’ in the number
of columns box and OK.

To Split Cells:- Select the Row- Click on merge group Enter 1 number of rows field and
OK.

Answer the following

1) A table is an arrangement of text in the form of rows and columns. It uses for
presenting information, in a tabular form such as calendars, progress reports and graph etc.
2) Inserting rows and columns, Merging cells, Aligning text in cells and tables

Deleting rows and columns, Splitting tale and cells, Formatting table

3) Cell Alignment is used to arrange the text in a cell more attractively.

To apply cell alignment, select the cell and select any option from Alignment group.

4) Sort option helps us to arrange texts in Alphabetical or Numerical order.

5) We can use Shading option in Design tab is use to apply background colour to the table.
6) Select the cell and click Split Table option from the Merge group.

7) To draw borders to the table, click Draw Table option in Draw group or Borders in
the Borders group on the Design tab. When you select Draw Table, a pen appears on the
mouse pointer. Use this pen and draw borders.

8) Select the cell and click on the Insert Above option on Rows & Columns group.
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Fill in the blanks
1) Mailings 2) Create 3) Preview a mail merge 4) Finish group
5) Finish & Merge  6) Mailing  7) Merged 8) .mdb

Identify the option and write their group name
1) Write & Insert fields 2) Create group 3) Finish group
4) Mail merge group 5) Preview Results group

State True or False

1) False 2) True 3) True 4) True 5) False
Match the following

1) Alt+Shift+M 2) Mailings  3) Customize Columns

4) Alt+Shift+N 5) Alt+Shift+K

Tick the correct option
1) Ms Word  2) Select Recipients 3) Mail Merge 4) Mailings, Finish 5) Create

Answer the following

1) Mail merge allows you to create letters by linking a main document to a set of

data source.

2) The main document contains the text and graphics that are same for each of the
merge document.

3) Data source is an organised collection of information. Click the option Select
Recipients from Start Mail Merge group on Mailings tab. Select type a New List option
from the drop down list then New Address List dialog box will appear.

Fill the fields with recipient address. Click on OK button after entering all addresses
Then Save Address List dialog box appears. Type a file name for the file that will store
your mailings list and click on save button. Now the data source (Address) is created.

you can combine the main document with this data source.



4) Click on Envelopes option in the Create group on the mailings tab. Then Envelopes
and Labels dialog box will appear.

Type delivery address in the Delivery address tex box and type return address in the
return address text box.

5) Click on Print Documents option from the drop down list of Finish & Merge option
from Finish group.

6) Preview results group on the Mailings tab. Then click on the Next button to view the document.
7) New entry button is used for add new addresses on the Mail Merge.

(ITG-VII 5 More on Python )
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Fill in the blanks

1) Type() 2) Constants 3) Input()

Answer the Following

1) Constants are variables whose values do not change during the lifetime of the program.
Unlike languages like C or Java; Python doesn’t have a special syntax to create

constants. We have created constants just like ordinary variables. However, to separate
them from an ordinary variable, we use all uppercase letters.

>>>

>>>MY CONST=100#aconstant
>>>

You are even allowed to change the value of MY CONST constant by assigning new
value toitas follows:

>>>
>>>MY_CONST="new value"

2) Escape sequences are set of special characters used to print characters which can’t be
typed directly using the keyboard. Each escape sequences starts with a backlash
character. The following are some common escape sequences.

\n :- Newline \’:- Single quote \b :- ASCII Backspace
\t:-Tab \”’:- Double quote \f:- ASCII Form feed
\\:- Backslash \a:-ASCII Bell \r :- ASCII Carriage Return

\v :- ASCII Vertical Tab



3) The following base data types are used in python.
a) Integer:-12,-999,0,3434, etc
b) Real numbers:-4.5,-25.4211,0.00003 etc
¢) Characters:- ‘hello’, 100°,"$##$’, etc
4) 1 Canbeofanysize.
2 Haveallowed characters, which are a-z, A-Z, 0-9 and underscore (_)
3 Should begin with an alphabet or underscore.
4 Shouldnotbe a keyword.
5) print('1\n1\t2\n")

print('1\t2\t3\n")

print("1\t2\t3\t4\n")

print("1\t2\t3\t4\t4\n")
(ITG-VII 6 MORE ON EXCEL )
I Fill in the blanks
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1) Workbook  2) Home tab ~ 3) Unmerge cells 4) Column  5) Ctrl +;
6) Ascending Auto fill 7) Cell pointer 8) Data validation

Multiple choice question

1) AutoFill ~ 2) Merging 3) Three 4) Relational ~ 5) Data 6) Review
State True or False

1) False 2) True 3) False 4) False 5) True 6) True
Match the following

1) <= 2) & 3) OR 4) Paste 5) Worksheet

Write the use of following shortcut keys

1) To select entire row 2)Navigation sheet upward 3) Navigation sheet downward
4) To insert time 5) To insert current date

Answer the following

1) To select a single column, click on the column heading at the top of the column.
To select a single row, click on the row heading.

2) Merging cells means combining two or more adjacent cells into a single cell.
Some other merge option are: Unmerge Cells: It is used to remove merging effect.
Merge Across: It is used to merge the cells across only. Merge & Center: It is used ti

merge the cell with the contents aligned to center.



3) All expressions are evaluated from left to right. When two or more arithmetic
operators are used in an expression. B- Brackets, O- Of, DM-Division and
Multiplication, AS- Addition and Subtraction

4) Auto Fill is the easiest method to fill data in cells automatically. It is used to fill a
series of numbers, number and text combination and dates or time periods based on a
pattern. Flash fill feature that fills the data in cells by picking up the pattern set

5) (A) E20: El (B) H50: H8

6) Text Formula, Numeric Formula, Logical Formula

7) Spreadsheet contains data and information arranged in rows and columns. It is also
called worksheets. A workbook is made up of one or more worksheet. Default 3

worksheets in a workbook.

(me-wn | 7 CONDITIONAL FORMATTING )
I Fill in the blanks
1) Databars  2) Gridlines 3) Chart  4) Treemap chart  5) Sunbrust chart
11 Multiple choice question
1) Legend 2) Waterfall 3) Design 4) Sunburst
I State True or False
1) False 2) True 3) True 4) True 5) False 6) True
v Match the following
a) Design tab b) Visual guides ¢) Column chart d) Insert tab
\% Fill the crossword
1) Sunburst  2) Pareto 3) Waterfall 4) Histogram 5) Treemap
VI Name the following option in the conditional formatting button
1) Colour scale 2) Data bars 3) Icons sets 4) Top/Bottom rules
VII  Answer the following

1) It is used to format selected cell or cells that meet a specific condition based on
values or formulas which you specify. It helps to highlight a unique cell or range of

cells, emphasise unusual values, visualise data by using data bars, colour scale and icon sets.

2) Color Scale are visual guides that help us understand data distribution and variation.

It helps to compare the range of cells by using a gradation of two or more colours.



3) To click on the Recommended charts option in the chart group on the Insert tab to

quickly create a chart.

4) A waterfall chart is also known as an Excel bridge chart since the floating columns

make a so called bridge connecting the end points. Treemap this chart displays

hierarchically structured data.

5) Click on Conditional Formatting button and point to Data Bars. Then select relevant

data bars from the list then you can see the data bar increasing from one to ten numbers.

6) To clear all conditional formatting from the entire sheet, select Clear Rules from

Entire sheet option from the Clear Rules drop down list of Conditional Formatting.

7) Format highest or lowest values in a range of cells based on a cut off value that you

specify.

8) Sunburst chart is a pie chart that shows relational data sets. The inner rings of the

chart relate to the outer rings. A Pareto chart contains both bars and a line graph.

(m-wn | 8 FUNCTIONS IN MS EXCEL )
| Fill in the blanks

1) Complex 2)=(equal) 3)SQRT 4) Logical 5) Cell 6) Mathematical
I State True or False

1) False 2) True 3) True 4) True 5) True 6) True

I Multiple choice questions
1) Max() 2) MIN 3) POWER
1A% Match the following
1) Number of cells within a range.
3) Check more than one condition.

5) To find factorial of a number

4) COUNTIF

2) Add values in a specified criteria.
4) To find length of a string.



Answer the following
1) The values inside the bracket in a formula are called Arguments. It can be
numbers, texts, logical value, array or cell references.

1) Constants as arguments 2) Cell or Ranges as arguments 3) Functions as arguments

2) POWER function returns the result of a number raised to a power.
Examples:= POWER (30,2) returns 900.

3) A valid function should be in sequential order. A set of rules for doing something

is an orderly manner is called Syntax.

4) MAX function returns the highest number in the selected range.
Example:= MAX (B2:B6) returns 96

MIN function returns the smallest in the selected range.

Example: = MIN (B2:B6) returns 20

5) Date and Time functions are used to display the date or time in a cell. It can also
make some calculations.

Example: To know the date after fifty days from the current date, type the formula
as:=Today ()+50.

6) SUMIF function adds the values in cells specified by a given condition or criteria.
The main advantage of this function is, it can add the number that meets the given
condition or you can make the sum range of cells or a column with respect to the data in

another column.

7) LEFT It returns the first character or characters in a text string, based on the number
of characters that you specify. Example:= LEFT(”GOOD LUCK?”,2) returns “GO”.

8) COUNTIF function counts the number of cells within a range that meet a given
condition. Syntax: = COUNTIF (range, criteria) the following function is used to check

number of students earning marks above 160.
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